# Carnegie Mellon
Tepper School of Business

## 70-381 Marketing-I
Spring, 2010

<table>
<thead>
<tr>
<th>Instructor:</th>
<th>Kinshuk Jerath, Posner 372, 412-268-2215</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><a href="mailto:kinshuk@cmu.edu">kinshuk@cmu.edu</a></td>
</tr>
<tr>
<td></td>
<td>Office hours: Mon 2:30-3:30pm</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Recitation Leaders:</th>
<th>Section A</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Jian Ni</td>
</tr>
<tr>
<td></td>
<td><a href="mailto:jiann@andrew.cmu.edu">jiann@andrew.cmu.edu</a></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th></th>
<th>Section B</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Tanuka Ghoshal</td>
</tr>
<tr>
<td></td>
<td><a href="mailto:tghoshal@andrew.cmu.edu">tghoshal@andrew.cmu.edu</a></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th></th>
<th>Section C</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Young Eun Huh</td>
</tr>
<tr>
<td></td>
<td><a href="mailto:youngeuh@andrew.cmu.edu">youngeuh@andrew.cmu.edu</a></td>
</tr>
</tbody>
</table>
Course Information

Course Objectives
This is the core Marketing course for the Tepper Undergraduate Program. The course is required for majors in Business Administration and can also be taken by non-majors. The aim of the course is to provide a rigorous and comprehensive introduction to contemporary marketing practice and principles along with some hands-on training. The specific objectives of the course are:

- To introduce you to the concepts and terminology of modern marketing management.
- To train you to analyze complex business situations and to teach you the tools used by marketing managers.
- To introduce you to the techniques of marketing research and other tools used in the practice of marketing.
- To improve your professional skills of presentation and concise writing.
- To give you experience working in a team.

Course Organization

Textbooks

The Marketing Plan Handbook, and Pro Premier Marketing Plan Package by Marian Burk Wood, Prentice Hall; 3 edition (2007). ISBN: 0135136288. This is a good, short book that will help you with the classes and with your Marketing Plan (explained subsequently). However, all exams and assignments will be based on material covered in class and not on the book. I suggest that you buy it with a friend and share it. Feel free to use an older version.

Suggested Textbook
Principles of Marketing by Philip Kotler and Gary Armstrong. Prentice Hall; 13 edition (2009). ISBN: 0136079415. The book is not required for the course, but is a popular book used at various other schools. I believe it is good for some examples, but very verbose. I have not asked the CMU Bookstore to stock it, as I do not think it is necessary. If you do want to buy it, feel free to buy an older version online or borrow from a friend.

Format
Lectures are on Monday and Wednesday and recitations on Friday. The recitation sessions are not optional review sessions but an integral part of the course. Careful preparation of each assigned case is essential before you come to the case discussion. The case discussions depend on your active participation and Class Participation is an important part of your grade.

Course Website
All relevant material related to the course will be posted on the Blackboard (www.cmu.edu/blackboard). Schedules, group membership assignment, and class notes will be made available at the time they are needed.
All assignments are to be submitted to the electronic dropbox on the blackboard. Paper copies in class are not accepted.
Basis for Final Grade

Exams. The purpose of the exams is to encourage you to study the basic material discussed in class and the recitations. Exams will consist of a varying number of multiple-choice questions and a few essay-type and/or analytical questions. The midterm exam covers the first half of the material. The final exam emphasizes the last half of the course, but also includes concepts and questions covered in the first half of the course. I will provide you with sample practice questions before the exams.

Case Briefs. The case briefs are individual assignments. These assignments will familiarize you with marketing issues faced by real companies, improve your analytical skills, and develop your business writing skills. Copies of the cases are included in your course package. There will be preparation sessions for the cases. For each case brief you will be asked to respond to discussion questions that will be distributed during the semester. Your briefs should not exceed 1 single-spaced page (see “Guidelines for Case Briefs” and the Sample Case Brief). Case briefs are due at 9 am on the day the case is discussed.

Assignments: There are two assignments, one quantitative assignment and one essay assignment. The quantitative assignment will provide you with a working knowledge of the tools commonly used in the industry and show you how quantitative data may be used in important marketing decision-making. Specifically, you will analyze real sales data with regression analysis in Microsoft Excel. Although most students entering the class should have taken a class in basic statistics, this is not a prerequisite. I will teach you everything you need to know in order to complete the assignment.

The essay assignment requires you to carefully read the textbook “Made to Stick.” Then, choose a product or idea on your own that you think has “stuck” and, following the framework of the book, explain why you think it stuck. The essay should not exceed 4 double-spaced pages.

Quiz: There will be 2 optional unannounced pop quizzes. Each quiz can earn you up to 2 bonus points (5 correct answers = 1 point; 8 correct answers = 1 ½ point; 10 correct answers = 2 points). You are all encouraged to take the quizzes as they can only improve (and not harm) the over all grade. These quizzes are especially designed to help you assess your knowledge and earn points without any costs.

Marketing Project and Group Presentation. Teams will present their work in class in addition to submitting written reports at the end of the semester. The project will help you apply marketing principles to real complex business situations. The team presentation will improve your professional skills of presentation and give you experience working in a team. In this semester-long project, your team will complete a marketing plan for an existing company of your choice. Your plan can deal with any of the following issues facing the company:

- Marketing an existing product/service in an existing market
- Marketing an existing product/service in a new market (National or international)
- Marketing a new product/service in an existing market

You will be assigned randomly to a group of approximately five students (all will be in the same recitation section). Experience has shown that this method allows for a better complementary match of people with different backgrounds and skills than teaming up with your friends. The ensuing situation closely resembles a typical business environment where you are expected to work in teams without necessarily knowing the other members of the team in advance. Therefore, switching teams or sections will not be possible.
Expectations for Part I, II, and III. Throughout the whole semester, the marketing project is separated into three stages. Marketing plan Part I, Part II, and Part III will be integrated into a final report that will be presented in class. The presentation and the final report are graded but the separate Parts I, II, and III are not. For them, the lecturer and the recitation leaders will provide feedback before and after the due date of each part.

In Part I, you are supposed to collect background information and define the problem you will be working on. In Part II, you are supposed to conduct a market analysis and design a research plan. You will collect data to study consumer demand and potential marketing opportunities, and analyze the data. In Part III, you develop marketing strategies in terms of elements of the marketing mix.

Final Report. The final report will cover Part I, II and III. Limit your final report to 20 single-spaced pages (excluding appendices).

Presentation order: A list will be made available to indicate your preferred date for the presentation. Note that an early presentation will give you more time to accommodate feedback in your final report.

Due date: All case briefs and assignments are to be submitted to the electronic dropbox on the blackboard website (www.cmu.edu/blackboard) before 9 am on the due date. Missing the deadline results in 0 points.

Grading: I grade your assignments and case briefs with help from the TAs, who are Ph.D. students. You can only appeal a grade if there is a clear misreading of what you wrote. Write a memo explaining your disagreement, keep a Xerox copy of your brief and the original and re-submit to the grader(s) responsible. The TAs hold office hours and can give you suggestions for improving your work but they do not respond to emotional appeals.

“Free Rider” Problem: In the business world you live and die by the results of your team as a whole. We prefer to give a single grade to all members of a group, but understand that there may be substantial “outlier” behavior by particular group members. When handing in the final report, you will also hand in a peer evaluation form rating the contribution of each team member. Since a significant proportion of your grade depends on group work, the peer evaluations are taken very seriously. If there appears to be consensus that one group member did not pull his or her weight (or alternatively, that one member was crucial to the team’s success) I will adjust an individual’s project/group assignment grade up or down according to the peer evaluations. Please be fair in rating others. A copy of the peer evaluation form is included; copies can also be found on the blackboard.

Class Presence and Participation. Class participation points are given to encourage your active class participation in lectures and during discussions. You will be rewarded with a perfect score as long as you frequently come to class and actively contribute to the class discussion. Linking the course material to your own experiences/ideas would enhance the learning experience for you, your classmates, and myself.
Presence: Although it is not required, most students send their professor a brief e-mail to explain their absence in advance. Students who repeatedly arrive late to the lecture or recitation will have their Class Participation grade lowered.

Feedback
It is my goal to make this an excellent course. If at any time you feel that the course is not meeting your expectations or you want to provide feedback on how the course is progressing for you, please do not hesitate to contact me.
Summary of Grading Criteria

**Midterm (15%) and Final Exam (15%).** The exams will encourage you to study the basic material (definitions and applications of concepts).

**Marketing Project and Group Presentations (25%).** The project will help you apply marketing principles to real complex business situations and will give you experience working in a team. A team presentation will improve your presentation skills.

**Case Briefs (30% --- 3 written case briefs 10% each).** The case briefs will help improve your skills of critical business analysis, concise business writing and ability to assess a situation from different perspectives.

**Assignments (10% --- 2 written assignments 5% each):** The quantitative assignment will provide you with a working knowledge of regression and show you how quantitative data may be used in important marketing decision-making. The essay assignment will help you to understand why and how persuasion techniques work—or fail to work.

**Class Attendance & Participation (5%)** Class participation points are given to encourage your active class participation in lectures and during discussions. You will be rewarded with a perfect score when you regularly and actively contribute to the class discussions. Linking the course material to your own experiences/ideas would enhance the learning experience for you, your classmates, and myself.

**Extra Credits (7% points):**

**Participation in Experiments (optional):** These points are optional and are given as extra credit. You can earn up to 3 extra credit points by participating in experiments conducted by Tepper School faculty in Marketing, Organizational Behavior, Economics, and Information Systems. More detail on how to sign-up for experiments will be provided during class.

**Pop Quiz (two unannounced tests 2 points each).** The bonus quizzes will encourage you to stay current with the lectures and makeup if you are falling behind. You can earn up to 4 bonus points through these quizzes.

**Final Grades.** All credits from the required parts (exams, marketing project, case briefs, assignments, and class participation) are summed up and graded following a normal distribution, with roughly 20% A, 50% B, 20% C, and 10% D. Extra credits are then added to the final score, so you can ‘move up’ in the distribution.
Grading of Case Briefs

1. Format
   Correct  1
   Minor problems  ½
   Major problems  0

2. Appropriate usage of marketing terminology, grammar, spelling
   Perfect  2
   1 or 2 errors  1
   Many errors  0

3. Clear point of view
   Well-stated, strong arguments  3
   Good POV, not well supported  2
   Good support, no clear POV  1
   Too many ideas  1
   Wrong focus  0

4. Assumptions, risks, uncertainties
   Fully discussed  2
   Fair effort  1
   Not addressed  0

5. Recommendations, action steps
   Clear, excellent  2
   Fair, imperfect  1
   Vague, not stated  0

   Points off

6. Logic
   Rambling  -1
   Some inconsistencies  -½

7. Irrelevant issues  -1, -½

8. Excessive restatement of case facts  -1, -½

9. Other

Total  max 10
Grading of Marketing Project
(25 points in total)

1. Final Report 20 points

- Clear definition of marketing problems faced by the firm.
- Necessary information collected (library sources, survey, etc.).
- Correct marketing research method. Appropriate financial analysis.
- Thorough, strong, practical, creative and consistent marketing plan.
- Strong basis to support your recommendation.
- Practical action programs.
- Clarity and conciseness in writing.
- Thorough coverage of issues raised during presentation and feedback

2. Presentation 5 points

- Message clearly communicated to audience
- Use of marketing terminology
- Professional and persuasive presentation style
- Readability of slides, confident handling of equipment, lighting
- Speaking, eye contact, posture, gesture, movements
- The result appears as if the team worked well together
- Good match of speaker to topic
- Good hand-offs
Guidelines for Case Briefs

Writing Individual Briefs

Write in a professional style as if you were a consultant to the firm, giving your best (and highly paid!) advice. Use strong and active verbs and appropriate marketing terms and concepts. The styles of Business Week and The Wall Street Journal are good models in most instances. You will end up with some well-crafted sentences that your English teacher would call “run on”, but they may be efficient in business prose: “I recommend that Mr. Whitfield immediately reduce costs by canceling TV advertising, laying off surplus warehouse staff, reducing R&D spending to 2006 levels and avoiding construction of the proposed San Diego factory. Further, I suggest an intensive market penetration strategy by offering 10% volume-based price discounts for a three month period starting July 2008.”

In most business situations, there are two or three possible courses of action. There is rarely a single "right" answer for each case, just as there is rarely a single right marketing decision in actual business practice. Marketing is a set of skills, concepts, knowledge, analytical techniques and approaches which, when applied appropriately and consistently, can greatly enhance the effectiveness of business. Your recommendation should be specific and based on comprehensive reasoning and rigorous analysis. Sometimes you will need to make assumptions to justify some of your arguments. In that case, make sure that you explicitly state those assumptions and provide for contingency actions if they do not hold.

Don't be afraid to commit to one strategic alternative (e.g., recommend price discounts) although this will rule out other options (in this case, more advertising). However, this is not to say that there are no wrong answers. For example, recommending heavy promotional expenditures by a firm about to become bankrupt doesn't make sense. Think of the four elements of the marketing mix, all the pros and cons of your recommendation versus those of alternative strategies, consider the possible implications and ramifications, and make a decision.

Format

Your briefs should not be more than 1 single-spaced page, accompanied by a maximum of three relevant exhibits. Running over the page limit for text will lead to a penalty in the grade. The format must be strictly followed: 1 inch margins on all sides; at least 10-point font size. Identify your brief with your name, section and the name of the case. This information may be in the top margin.

The exhibits can be spreadsheets, tables, flow diagrams, plots, charts, etc. and should be referenced from the text. They should be relevant and should contain brief narrative or description of what they illustrate.

Paragraph Headings: You may use running paragraph headings (as shown here) if it helps your writing.
Organization

There are many possible ways to write a well-organized, appealing brief. If you work in marketing, your employer will likely have a “house style.” But you should start with the following structure for this course. Also, make sure that you incorporate answers to ALL the discussion questions provided with the case in the following format.

Introduction: Very briefly (one sentence), identify the situation and who must take what decision, for example, “Lee Wang, Marketing Manager for Pontiac, must decide whether to increase promotional spending by $1 million and if so, where to spend the additional budget.” Do not repeat case facts, such as: “Pontiac makes cars and is a division of General Motors, one of the largest US corporations.”

Recommendation: This is the most important part. Avoid placing your recommendation at the end of the brief as a conventional conclusion in business; the reader may not get that far. You should make your recommendation explicitly. Do not hedge with wasted words such as “In my opinion.” Say what the executive or firm should do: “Lee should spend $1 MM on increased TV advertising in local spot TV in Southern and California markets, selecting shows with a high 25-35 female viewer profile.” Not a vague wish such as: “Pontiac should raise sales in selected markets.”

Basis for Recommendation: Back up your plan: Provide around three reasons why your plan makes sense, possibly including the rejection of alternate strategies. “Network TV has proved ineffective at boosting sales and a trial of radio ads was ineffective.”

Alternatives, Risks, and Assumptions: This part is the second most important. Outline key assumptions that you have made. Discuss possible uncertainties associated with your recommendation. For example, “This assumes that the increase in awareness in the small Peoria test-market can be replicated nationally.” And, “With weak ties to the distributors, Smithco will be vulnerable in this market if competitors decide to develop a similar product.”

Action Steps: What should be done today? Tomorrow? And in the next three months? Don't be vague, as in “Pontiac should rebuild its brand image.” Rather, “At the end of the first month, Lee should conduct awareness studies to measure the effectiveness of the new spot TV campaign and -if successful- should develop a new ad copy on the same theme and add dealer incentives.”

Appendix/Exhibits

You can include up to three exhibits such as tables, charts, Excel spreadsheets or organizational- or flow-charts. You must refer to the exhibit at the appropriate point in your text: "A sales increase of only 0.4 percent would completely cover the planned extra advertising costs (Ex. 2)." Sometimes you can explore possible outcomes by presenting the “worst, expected and best” scenarios - but do not print out endless iterations of the same idea (e.g., net profit at 0.1, 0.2, 0.3 ... 8.9 percent sales increase).
Technical Issues

Use a spell checker. Then carefully read through your work and make appropriate corrections. Make sure all your recommendations are consistent and compatible with each other. Don't have another person do the proofreading. We want you to learn good editing skills as well as good writing.
Sample Case Brief
TO: Richard Knight, VPA P.R. Director
FROM: X
RE: 2006 Marketing Plan

Excellent!
10/10

Introduction
I recommend you adopt Ms. Dewey's plan and that you simultaneously reorganize your operating hours and communication expenditures to accommodate the changes this plan brings about in your service.

Recommendation
My recommendation has three parts. First, adopt Ms. Dewey's program but increase the children's admission to $3.50. Second, reorganize your operating hours so that they can be consistently recalled by members of the public, regardless of the season. Specifically, make your new operating hours 9am to 9pm every day with weekday general admission open from 3pm until 9pm. Utilize the print, television and, radio news media to call attention to the new “quiet hours” available after 3pm. Finally, make the following changes in your communication program: Cut billboard expenditures by $12,600, eliminate $18,400 in magazine fees by making the membership magazine bimonthly, and channel these savings into radio and TV advertising during the winter months.

Basis for Recommendation
Ms. Dewey's Program. Implementing the program will increase the exposure of schoolchildren to the aquarium; a VPA objective. Clearly, the program will satisfy both teachers and the portion of the general public that considers the tours a distraction. The $1.00 increase in fees can be justified by the fact that the school tours are receiving exclusive use of the premises during our morning hours. In addition, the dollar increase is likely sustainable since the teachers are unlikely to be affected by a fee increase carried by parents. As the attached financial analysis indicates, this program can be implemented without a loss as long as 55% of the general admissions during the school tour hours reschedule. The likelihood of this happening is increased by our expanded hours.

Expanded Hours. The expanded hours program has a number of benefits that promise to increase attendance. First, it accommodates rescheduling caused by Ms. Dewey's program. Second, it allows for consistent hours of operation that are more likely to be remembered by the general public. Third, working families are provided the opportunity to visit the facility on weekday evenings. Finally, the “quiet hours” offering is likely to attract new admissions, who may have previously been turned off by the noisy daytime environment. Together these four factors will improve our weekday and off-season attendance; a goal which is consistent with VPA's objectives. As the accompanying financial analysis shows, if the new hours increase attendance by only 3%, VPA can overcome any revenue lost from closing the facility to evening rentals. The history of good relations between VPA and news media represents a low-cost opportunity for disseminating information to the general public.

Reorganization of Communication Expenditures. Analysis of your data shows that current communications expenditures may not be appropriated in the most effective manner. Billboard advertising was not cited as a cause for learning about the aquarium. Magazine fees are also significant and are generally not critical in bringing in new admissions since the magazines are generally sent to current members. Reducing the magazine to bimonthly can be justified to the membership as a cost saving which they are likely to support. These net savings of $31,000 should be appropriated to TV, radio, and brochure advertising, which have the lowest cost per thousand admissions reached at $40, $520 and $540 respectively. The emphasis in this advertising should be on gaining new admissions during the winter months and expanding hours.

Alternatives, Risks, and Assumptions
One alternative was to eliminate the most expensive advertising. This was not recommended because some of these media serve a useful purpose as reminders. One risk is that the aquarium will not be able to locate enough docents to implement the volunteer program; a factor that was assumed possible in the recommendation.

Next Steps: Set a date for implementation and begin contacting news media representatives.
Guidelines for Marketing Project

Marketing Plan

You and your team members will complete a marketing plan for an existing company of your choice. It is strongly recommended that you choose a small company in your vicinity and make a realistic plan in consultation with this company, rather than choosing a multinational company that does not even care about the insights you provide. Teams will present their work in addition to submitting a written report at the end of the semester. The recitation leaders will help you to get started. The professor and recitation leaders will be available for assistance if you need additional input. The recommended textbook (Marketing Plan Handbook) will also be of great help. You do not have to adhere to the format in the CD accompanying the book.

Some projects in the past included marketing plans for:
- Kennywood
- Pittsburgh Farmers’ Market
- Pittsburgh Pirates
- Restaurants around campus (Spice Island, Orient Express, Maximum Flavor, etc.)
- Pratique Yoga (yoga shop in Lawrenceville)
- CMU Bookstore
- Larger companies (Loews, Motorola, Nintendo, T-Mobile, Whole Foods, Wendy’s, etc.)

Part I - Background and Problem

Identify a marketing problem for an existing company. The problem may pertain to different issues, including the introduction of a new product, repositioning of a product, market penetration or market development, diversification, whether and how to extend a current line of products, how to increase profits when the demand/profitability of an existing product is declining, global marketing etc. Pretend you are addressing a hypothetical Board of Directors. The Board will make a GO/NO GO decision based on your first report.

Conduct a marketing audit and describe the company. To obtain relevant information, consult secondary sources in the library, on the Internet, electronic databases, business magazines and journals, annual reports and other reports.

Describe in detail:

- **Company.** Start by selecting a company and collect brief background information about it. Articles in Business Week, Forbes, and the Wall Street Journal may help you choose a company that currently faces an interesting marketing problem. Describe the overall strategic plan of the company, including its mission statement, company objectives and goals. In case your problem/product pertains to a particular brand or strategic business unit, focus the discussion on them.
- Clearly state the **Problem** that you are planning to address. Identify your objectives.
Part II - Market Analysis and Research

Conduct a marketing audit and describe the company’s marketing situation (library, Internet, electronic databases, business magazines and journals, annual reports and other reports. You may also want to contact the company and inquire about existing internal data sources and ask permission to use them for your analyses)

Describe in detail.

- **Market situation.** Present relevant data on target market(s) over the past years, including the composition, size, and growth of the market segments. Previous studies on similar products may help you to present data on consumer needs, perceptions, and buying behavior trends.
- **Product situation.** Describe the company’s product offering, sales, prices, contribution margins, net profits.
- **Competitive situation.** Identify and describe the major competitors that satisfy similar needs, including their size, goals, market share, product quality, marketing strategy, and positioning.
- **Distribution situation.** Present data on the size and importance of each distribution channel. How does the product/service reach the customers? Are there distributors? Is it available in stores (which ones), though direct mail, or on the Internet? Does the company sell directly to customers?
- **Macroenvironment situation.** Describe socio-economic and demographic trends that may influence the performance of the company/brand/product in the future.

Then, identify the product strengths and weaknesses, as well as the opportunities and threats that the business is facing. In other words, conduct a *SWOT* analysis. Identify opportunities that match strengths of the company/product and threats that may harm future activities.

Determine the specific information needs. What additional (primary) information will you need to formulate marketing strategies? Collect information on consumers (e.g., demographics, lifestyles, psychographics, purchase patterns, etc.), your product (e.g., positioning, willingness to pay, purchase intention, etc.) and competitors (e.g., positioning, loyalty, etc.) Carefully develop the research plan for collecting the information. Develop and describe the following *Data collection method* (survey, experiment, observation, focus groups, historical data, and/or statistical databases. You may need more than one method) and *Data analysis method* (If you have formulated particular hypotheses, design appropriate statistical tests to test these hypotheses - recitation leaders will help you with this).

After the research plan has been specified, it is time for its implementation. Collect, code, and analyze the data according to the research plan. Based on the first results you may want to adapt your initial research plan and redo some of the analyses. Then interpret and report the most important findings that are related to your marketing problem.
Part III – Marketing Strategy Development

**General marketing strategy.** Develop a new marketing strategy based on the information collected in Part I and Part II. First present the marketing strategy in general terms, addressing the following issues (if applicable):

- **Target market(s).** Describe the market segments that will be targeted.
- **Positioning.** How will the product be positioned in the market, given the positions taken by competitors?
- **Marketing mix.** Specify each element of the marketing mix. For example:
  - What product(s) will be offered to the market? Is it a product modification, variant, or innovation?
  - Based on what product attributes is the product positioned in the market?
  - What price will the consumer pay? Do you recommend segmented pricing? Specify it.
  - What sales force activities will you recommend?
  - What channels will be used to distribute the product?
  - Which advertising media will you use for your communication message(s)?
  - What level of advertising spending do you recommend?
  - What is the general communication message to the customer?
  - Will you be offering sales promotions?
  - ……
- **Research.** What additional marketing research is needed to track consumer preferences and competitors' actions? Is additional investment in R&D desirable?

**Action program.** Specify each element of the marketing strategy. What will be done when and what are the costs of the specific actions.

**Budgets.** Also provide a detailed marketing budget for implementing the strategy. Assume that the total marketing budget that you have at your disposal is half of the current (existing) marketing budget. This requires you to develop new creative marketing ideas that are more effective but less expensive than what the company has done so far. Specify the projected revenues, costs (fixed, variable) and profits, and how you allocate resources.

**Controls.** Outline the controls for monitoring the plan’s progress. Specify goals and budgets for the first 8 quarters.

**Communicating the Plan**

**Team Presentation.** You are to take the role of a group of consultants presenting to the Board of Directors of the firm. As on any Board, some members know more about the issue than you do, and all will be generally familiar with the firm's situation. But some members have had only a slight opportunity to read the material before a meeting. Leading them through the situation, your analysis and recommendations require considerable skills to hit the right level of detail, without endlessly reciting case facts. Of course, the same is true for your classmates - some of them have had other courses than you and are ready with tough questions; some will know the facts. Try to
appeal to all these segments. Also make sure that each member of the group gets some “air
time.” This is difficult to do in practice, but is very effective if the group is well rehearsed and
the changeovers are seamless. Be well-prepared and pay extra attention to the substantive
content, materials and style of the presentation.

Notes:
(1) Practice your presentation well. Your team will have 10 minutes to present the plan.

(2) If you plan to prepare a PowerPoint presentation, please make sure that you thoroughly
test it in the classroom. Too often, presentations fail because of problems related to
PowerPoint. You are advised to bring overhead transparencies as a backup.

(3) Check out the presentation equipment available in the classroom.

(4) On the day your group is presenting, make sure that all of you are on time.

Final Report. You will prepare the final report for the Board of Directors and the departments
involved in the execution of the marketing plan. The report will integrate Part I, II and III. You
can use the basic structure as outlined for parts I to III (see Marketing Plan). Plan the writing of
the report in advance, make a division of tasks and start on time. While working on Parts I, II,
and III, consider the consistency among the corresponding sections of the report. Distribute the
workload evenly among team members and over time. Include a title page, table of contents, and
add a cover to your report. Aim at a length of around 20 pages plus appendices. When preparing
the report pay extra attention to the items listed under ‘Grading of Marketing Project.’

Additional issues related to the presentations

1. Bring 10 copies of the overhead slides (2 slides on 1 page) to give to the Board of Directors
(see below), the TAs and me.

2. You can use my laptop for your PowerPoint presentation. In this case, bring your presentation
stored on a USB stick to class. You may want to test beforehand whether it works (in the past I
have encountered incompatibility issues between MAC and PC, I have a PC laptop).

3. Another team not presenting will serve as Board of Directors, will ask questions and will
comment on the project. Participating in the Board of Directors will also count for your
participation grade. Teams will be called at random to serve as Board of Directors, so all of you
should attend the presentations!

4. Rehearse your presentation and time it so that you do not exceed the allotted 12 min. per team!
NOTES ON THE DESIGN & USE OF REGRESSION

The purpose of this document is to provide an overview of the regression models that will be used in this course. All assignments can be done using Microsoft Excel but you are free to use any software such as SAS, SPSS, etc. Because marketing is becoming more scientific as more high-quality data become available, it is necessary for managers to understand how to develop statistical models and then use them in day-to-day decision-making. This note will:

- Review key regression analysis concepts
- Describe how to interpret typical regression analysis output
- Describe how to use Excel to conduct regression analysis.

1. THE DESIGN AND ESTIMATION OF A REGRESSION MODEL

Recall from your basic statistics courses that regression provides a statistical analysis of the relationship between a dependent variable and a set of independent or explanatory variables. Consider the following mathematical model:

\[ \text{discount} + \text{Price} = \text{Sales} \]

The dependent variable in the above equation is sales, and the two independent variables are price and discount. The purpose of regression analysis is to estimate the unknown coefficients, \(a\), \(b\), and \(c\) in equation (1) using observed data for sales, price and deal discount. The coefficient \(a\) is called the intercept, and theoretically represents the sales level when both the price and deal discount are zero. The coefficient \(b\) represents the responsiveness of sales to changes in price, holding all other variables (in this case deal discount) constant. Similarly, the coefficient \(c\) represents the responsiveness of sales to changes in deal discount, holding price constant.

1.A Functional Form of the Model

NOTE: In this class we will just use the simplest form: linear regression. This is just for your information.

In building a model the first step is determining the appropriate functional form. The functional form of the model refers to the specific mathematical form of the equation and variables used in the equation. Most regression models are formulated as linear in the coefficients. Linear means that the coefficients have exponent 1 and that there are no coefficients multiplied together. Most regression programs require the equation to be linear in the coefficients but do not require it to be linear in the variables.\(^1\) For example, a semi-log model is:

\[ \ln(\text{Sales}) = a + b \times \text{Price} + c \times \text{Deal discount} \]

\(^1\) Non-linear regression programs are available but are beyond the scope of this note.
While this model is non-linear in sales, it can still be estimated using linear regression analysis because it is linear in the coefficients \((a, b, \text{ and } c)\). Similarly the log-log model given in equation (3) can be estimated using linear regression analysis.

\[
\ln(\text{Sales}) = \ln(a) + b \ln(\text{Price}) + c \times (1 + \text{Deal discount})
\]  

(3)

Is equation (4) linear in the coefficients?

\[
\text{Sales} = a + b \times \text{Price} + c \times \text{Deal discount} + b \times c \times \text{Deal discount} \times \text{Price}
\]  

(4)

The answer is no because the coefficient on the variable defined by Deal discount \(\times\) Price (i.e., the coefficient given by \(b \times c\)) is the product of two other coefficients in the model. Can equation (5) be transformed to make it linear in the coefficients so that it can be estimated using regression analysis?

\[
\text{Sales} = a - b^2 \times \text{Price} + c \times \text{Deal discount}
\]  

(5)

Yes by letting \(b^2 = d\) and then rewriting equation (5) so that it becomes:

\[
\text{Sales} = a - d \times \text{Price} + c \times \text{Deal discount}
\]  

(6)

The equation is linear in \(d\) and can therefore be estimated using regression analysis. Assuming the estimate of \(d\) is positive, we can then recover \(b\) (up to its sign) by taking the square root of \(d\). The choice of the functional form depends upon how the researcher or manager believes the effect of the independent variable(s) influences the dependent variable. For example, if one believes the effect of deal discount on sales is linear (goes up proportionally), then the “functional form” for deal discount is Sales = \(c\) \times Deal discount. If one believes that sales increase exponentially with respect to deal discount, then the functional form should be Sales = \(\exp(c \times \text{Deal discount})\). One way to determine the appropriate functional form is to plot sales versus each variable. If the effect appears non-linear, then try to find the appropriate mathematical transformation, which makes the relationship between the transformed, variable and Sales to be linear.

1.B Selection of Variables

Two methods can be used to determine how many and which variables to include in a model: (1) statistical methods and (2) model builder judgment. In this section we will focus on model builder judgment but one can also use the statistical significance of the t-ratio (or the p-value) and, if the variable is insignificant, eliminate it from the model. As a general rule, this is not a very good selection process and will not be the basis recommended for the selection of the model’s coefficients.

The recommended criteria for including a variable in the model are:

1.B.1 The Variable’s Importance in Making a Managerial Decision

For example, if you are modeling sales then variables like price, promotion, advertising, competitor prices etc. are important variables.
1.B.2 The Variable Helps to Control for Important Factors

Seasonality and trend are often included in models to control for other factors, because omitting them would cause spurious correlation between the independent variables and the dependent variable.

1.B.3 The Model Must be Parsimonious

The term parsimonious is used to indicate that the model should contain only “necessary” variables. While one can always identify other factors that can influence sales and might be included in the model, the best models are ones that contain as few variables as possible. Including too many variables in a model results in both “overfitting” and imprecise estimates of the models coefficients. Therefore, it is important to limit the model to critical variables. Deciding when a model is not parsimonious is difficult to determine but the rule should be: “Do not include a variable unless it is absolutely necessary.”

1.B.4 Are Data Available for the Variable?

In the real world, it is commonplace that data has not been collected for key causal variables. The reason is that the firm or the data vendor did not have reason to collect it or it is too expensive to collect. Therefore, while a variable may be important, data are not available for it. The rule is to do the best one can with the data available. A model will never be perfect and some analysis is almost always better than none. However, one must use judgment about what effect not including a key variable has on the model results.

1.C Methods to Estimate the Coefficients

The method most often used to estimate the coefficients in a regression analysis is called ordinary least squares (OLS). OLS minimizes the sum of the squared-errors that means that the estimated regression coefficients produce errors that have the lowest squared-error. The error is the observed value of the dependent variable minus its estimated value. The estimated value is computed by multiplying the observed values for the independent variables by the appropriate estimated coefficients.

For example, suppose that the model to be estimated is:

\[ \text{Sales} = a + b \times \text{Price} + c \times \text{Deal discount} \]  

Let the estimate of \( a \) be \( \alpha \), the estimated value of \( b \) is \( \beta \) and the estimated value of \( c \) is \( \delta \). Then, the estimated value of Sales is:

\[ \text{estimated sales} = \alpha + \beta \times \text{Price} + \delta \times \text{Deal discount} \]  

The error, \( e \), (often called the residual) is:

\[ e = \text{observed sales} - \text{estimated sales} \]  

19
\( \alpha, \beta, \) and \( \delta \) are chosen so that they minimize \( e^2 \) from equation (9). \( e^2 \) is called squared-error. The actual calculations required to estimate the coefficients in a regression is done automatically using well-known equations\(^2\) which guarantee the estimated coefficients will minimize the squared-error across all observations.

2. **Evaluating the Estimated Model**

There are two primary evaluation methods that will be used: Face Validity and Statistical Validity. Each of these is described below.

2.A **Face Validity**

Face validity of the model evaluates whether or not the resulting model makes intuitive sense. For instance, what should the signs and magnitudes be in the model given by equation (1)?

\[
\text{Sales} = a + b \times \text{Price} + c \times \text{Deal discount}
\]  

(1)

One would expect that sales should decrease with an increase in price, and that sales should increase with an increase in the deal discount. Therefore, the estimate for the coefficient \( b \) should be a negative number, and the estimate for the coefficient \( c \) should be a positive number. If the estimate for \( b \) is positive, it implies that sales would increase with an increase in price which violates proven economic principles. (While there may be some anomalous products where this could happen, for instance, perfume, it rarely if ever occurs.) Similarly if the estimate for the \( c \) is negative, it implies that an increase in the deal discount would decrease sales which for theoretical reasons is unlikely to happen.

In both of these cases, when the estimate for the coefficient \( b \) is positive or the coefficient \( c \) is negative, the results are counter-intuitive, and the estimated model does not have **face-validity**. When a model does not have face validity, decision-makers will not and should not use the model. For instance, suppose that the regional marketing manager for a consumer goods manufacturer is provided by his or her assistant with an analysis which shows that the coefficient \( b \) is positive, i.e. sales increase with an increase in price. Should he or she believe and act upon these results? Clearly no (unless they have compelling reasons why the product in question behaves in this way, e.g. perfume). Therefore, if the model does not have face validity, then it should **not** be used to design a pricing or promotional strategy. This lack of face validity implies that the model does not capture the true relationship between the dependent and independent variables, and that further analysis should be conducted to determine the appropriate relationships.

2.B **Statistical Validity**

Once the face validity of the model has been established, the statistical validity of the model should be tested before the model is accepted. Statistical validity has two parts: coefficient statistical validity and model statistical validity.

---

\(^2\)The equations themselves are derived from calculus. You may recall that setting the first derivative of a function with respect to one of the variables provides a local minimum or maximum for the function. The equations for the OLS parameters are obtained in this way.
2.B.1 Coefficient Validity

Of the two types of statistical validity, the first (coefficient) is more important. Coefficient validity is measured by the “t-statistics” or p-values associated with the coefficients. The t-statistic associated with the coefficient determines whether a coefficient represents a true effect or whether it is due to chance. This can be seen from the p-value that is associated with each t-value. It indicates that if in reality there were no effect (the coefficient = 0), one would observe with p-probability the observed effect (the coefficient) by pure chance. For instance, in the model given in equation (1):

\[ \text{Sales} = a + b \times \text{Price} + c \times \text{Deal discount} \]  \hspace{1cm} (1)

Suppose the probability associated with the t-statistic for the coefficient \( b \) is five percent. This would imply that if price had no effect on sales in reality, one would had a chance of 5% of finding the observed effect of price on sales due to pure chance. So, the lower the p-value, the more confident one can be that the estimated coefficients represent true effects and are not due to pure chance. In general, p-values lower than 5-10% are accepted in academic research, that is we can infer from a coefficient with a p-value lower than 5-10% that the effect truly exists. In this case, the coefficient is said to be significant. Only significant coefficients can be interpreted with confidence.

However, the 5-10% benchmark is only a convention and should be treated with caution. The problem is that the t-statistics are affected by the correlation between the predictor variables, i.e. by the correlation between price and deal discount. For instance, it may be the case that lower prices (i.e. price decreases) usually occur at the same time as deal discount increases (this situation occurs when you want to communicate strongly to your customers that the price has been decreased). Therefore, there may be a significant correlation between price and deal discount, which makes it difficult to separate these effects. The implication is that the acceptable coefficient statistical validity is affected by the correlation among the predictor variables.

One should also be careful not to eliminate variables just because they are not “statistically” significant. The cause may be that the independent variables have very little variability or that several independent variables are intercorrelated. A low t-statistic is a warning and should be used to determine why the variability is insignificant, but in and of itself is not a good reason to drop a variable that is theoretically important to the model.

2.B.2. Model Validity

Model validity is generally measured by the adjusted-R² statistic. This statistic is a measure of the amount of variance of the dependent variable (in our case the variance in Sales) explained by the predictor variables. For instance an adjusted-R² of 0.80 indicates that the model explains 80 percent of the variance in sales. However, a low R², e.g. less than 0.50 for a time-series model, indicates that there is a large portion of the variance in sales which is not explained by the model, and may imply that some predictor variables are missing from the model, or that a different model may be required. In sales promotion models, low adjusted-R² values are often caused by an inability to fit the peaks that are the data points when a promotion occurs. Often a revised set of variables is needed to improve the predictive ability of the independent variables.
To test whether the overall regression is statistically significant, an $F$-test is used. The $F$-test indicates whether the regression line as a whole is significantly different than using only the mean value of the dependent variable to predict the observation. The $F$-test actually tests whether any of the model’s coefficients are significantly different than 0. An example is given below.

3. **Dummy Variables, Seasonality, and Trend Adjustments**

Linear regression assumes that all of the variables (both the dependent and independent) are at least interval scaled. Interval scaled means that differences between scale values are comparable. For instance, if you measure sales in terms of dollars, the difference between $2 and $3 is the same as the difference between $5 and $6. Two types of variables where this does not hold are called nominal (or categorical) and ordinal. Nominal-level variables are defined as those measurements where the number assigned indicates a category, but the different categories are not comparable. For instance, gender is a nominal-level variable. You could assign males a value of 1, and females a value of 2. However, the numbers assigned to each gender are not comparable, they only indicate the classification of the person’s gender. Ordinal variables, on the other hand, reflect some a rank ordering of the values on some dimension. However, distances between ranks may or may not be the same. For example, the letter grades A, B, and C are ordinally ranked indicators of student performance. However, the “distance” in performance (defined, say, as the percentage score on an exam) between a student earning an A and another earning a B may not be the same as that between the student who earns a B and the one who earns a C.

The purpose of this section is to familiarize you with the use of dummy variables and to demonstrate how these variables can be included in your regression models.

3.A **Dummy/Binary Variables and Seasonality**

Occasionally, you may work with a product category where you want to correct for seasonality of the sales. For instance, you may believe that the sales of ice cream are seasonal, i.e. because of the warm weather in the summer months, sales of ice cream tend to be consistently higher in these months. Similarly, there may be major events, i.e. the Fourth of July, Christmas or Thanksgiving where the sales of an item are especially high.

It is important to correct for the seasonal fluctuations of sales, because if you do not your predictions for each of the seasons will, in general, be biased: too low in the especially high seasons, and too high in the especially low seasons. The easiest way to correct for seasonality is to create dummy variables for the seasons. For instance, suppose you are working with data for an ice cream manufacturer, and believe that the sales are affected by the season: Winter, Summer, Spring and Fall. In this case, you would create three dummy variables to represent three seasons, and the fourth season would be the base level for comparison. An example of the model is:

$$ Sales = a + b \times Price + c \times Spring + d \times Summer + e \times Fall \quad (14) $$

For this model, the sales during the Winter are the base level, and the coefficients $c$, $d$, and $e$ represent the change in sales from Winter to Spring, Winter to Summer, and Winter to Fall, respectively.
If one expects a major increase in sales due to a special event such as Christmas for cooking or a major summer holiday for beer and soft drink consumption, dummy variables can also be used to estimate these “seasonal” effects.

3.D Time trends

Occasionally, you observe that the sales seem to have a general increasing or decreasing trend over time, independent of price and other predictor variables. In this case, you should include a time trend variable in the model to capture this effect. The reason is that if you do not include the time trend, your model will both under-predict future sales and over-predict past sales.

A time variable is straightforward to include in the model; you normally have an indicator of the week, month and/or year of the observation. It is important to ensure that the time variable is scaled as an interval-level variable which means DO NOT use the observation number as a time indicator unless you know that there is the same amount of time between each observation. Generally, the time variable for the first observation (week, month, etc.) in the data is set to zero, and then is increased for each further observation. For instance, suppose that you have weeks 29, 30, 33, and 34 as your data set. Then the time variable, T, would be set to 1, 2, 5 and 6 NOT 1, 2, 3, and 4. If you code the time variable as 1, 2, 3, and 4, then you have not appropriately accounted for the interval nature of the original weekly data.

The model becomes

\[ \text{Sales} = a + b \times \text{Price} + c \times T, \]

(15)

The change in sales for each time period is \( \text{Sales}_t - \text{Sales}_{t-1} = c \) assuming price did not change. Therefore, sales increase (or decrease, if \( c<0 \)) linearly with the passage of time.

4. ESTIMATING MODELS USING EXCEL

This section provides some examples of how regression models can be estimated using the spreadsheet package Excel. Only the sequence of menu activations are provided for Excel, and Excel for Windows has been used to generate the output and command sequences. As with most operations in Excel, there are many ways to accomplish the very same task. This note shows only one (but probably the simplest) of those methods. However, you should feel free to use whatever method you find most appropriate for your style of work.

4.A Data Organization

Excel stores data in the form of columns with alphabetic identifiers and rows with numeric identifiers. For example, if your data set has 25 variables they represent 25 columns (perhaps A to Y) in Excel. Data for the course will be provided in Excel format, though you should be aware that Excel offers several easy-to-use features to import data in various alternative formats. In general, one only needs to start Excel and then use the File→Open command to open the appropriate file. The Import Wizard will guide you through the remainder of the process. For example, Excel can
recognize and open Lotus-format files as well as files from most database applications automatically. Furthermore, with limited user guidance Excel can open any fixed-width or delimited file type.

Most versions of Excel require that the independent variables you want to use in your model be in contiguous columns of the worksheet. Moreover, you often may want to transform one or more of the variables (e.g., by taking the natural logarithm) prior to estimation. It is often useful to both copy the original worksheet as an entirely new sheet in the workbook and to create additional columns within these worksheets to reflect the new (possibly transformed) data. You can use Edit→Move or Copy Worksheet (and then check the ‘Create a Copy’ box) to copy the entire worksheet, and you can use any variety of the copy and paste or function commands to copy and/or columns in the worksheets.

4.B Data Analysis Using Excel

Excel offers a menu-driven, dialogue method of performing OLS regression. The way in which you access Excel’s regression tool depends on the set up of your system. This is based on the fact that Microsoft has chosen to include regression as a Macro worksheet Add-In in order to save space and memory for most users. Essentially, Visual Basic Macros can take up a lot of space, and Microsoft wants to offer a default configuration for its software that is convenient for the largest number of users. To check to see whether or not your configuration automatically loads the Analysis Tool Pack, select the Tools menu. If you have an entry near the bottom of the menu that says “Data Analysis” you are ready to go. If not, choose the “Add-Ins” option off the Tools menu. If you have installed the Analysis Tool Pack when you installed Excel, you will see a listing for “Analysis Tool Pack” and/or “Analysis Tool Pack VBA” at this point. Check these boxes and then click on OK. Excel will open the macro sheets for these two tool packs. For the remainder of this session, whenever you select the Tools menu you should see Data Analysis as one of the options.

From this point running a regression is very simple. Choose Data Analysis from the Tools menu, and you will be presented with an alphabetical list of data analysis tools. Scroll down to Regression and select this option. You will then be presented with a large dialogue box in which you specify the range of the dependent variables, the independent variables, and the output range (at a minimum). You are also able to specify a number of options. Some of the more useful options are the “Labels” box near the input range (so that you obtain nicely labeled output) and the “Residuals” box to request the regression residuals (to help assist in the evaluation of the fit of your model). However, please feel free to use whatever options best assist you in the development and assessment of your model.

After you specify the input and output ranges (and whatever options you desire) clicking on OK prompts Excel to run the regression and write the results to the output location you have specified (the default output location is a new worksheet). From this point you should examine the output and perform whatever additional analyses you prefer (e.g., plot of predicted vs. actual dependent variable values) to assess the model you have estimated.

3Sadly for us all, most users of Excel do not exploit the software’s data analytic capabilities.
Sample output from a regression of Sales on the independent variables Price Paid, Shelf Price, and Advertisement is provided below.

**REGRESSION STATISTICS**

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Multiple R</td>
<td>0.905321</td>
</tr>
<tr>
<td>R Square</td>
<td>0.819607</td>
</tr>
<tr>
<td>Adjusted R Square</td>
<td>0.815171</td>
</tr>
<tr>
<td>Standard Error</td>
<td>726.6054</td>
</tr>
<tr>
<td>observations</td>
<td>126</td>
</tr>
</tbody>
</table>

**ANALYSIS OF VARIANCE**

<table>
<thead>
<tr>
<th>Source</th>
<th>Degrees of Freedom</th>
<th>Sum of Squared Errors</th>
<th>Mean Squared Error</th>
<th>F-test</th>
<th>Significance of F-test</th>
</tr>
</thead>
<tbody>
<tr>
<td>Regression</td>
<td>3</td>
<td>2.93E+08</td>
<td>97548726</td>
<td>184.767</td>
<td>3.43E-45</td>
</tr>
<tr>
<td>Residual</td>
<td>122</td>
<td>64410558</td>
<td>527955.4</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Total</td>
<td>125</td>
<td>3.57E+08</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**REGRESSION OUTPUT**

<table>
<thead>
<tr>
<th></th>
<th>Coefficients</th>
<th>Standard Error</th>
<th>t Statistic</th>
<th>P-value</th>
<th>Lower 95%</th>
<th>Upper 95%</th>
</tr>
</thead>
<tbody>
<tr>
<td>Intercept</td>
<td>8559.909</td>
<td>1049.963</td>
<td>8.15258</td>
<td>3.18E-13</td>
<td>6481.410</td>
<td>638.42</td>
</tr>
<tr>
<td>Price Paid</td>
<td>-20319.2</td>
<td>1389.042</td>
<td>-14.6282</td>
<td>7.43E-29</td>
<td>-23069</td>
<td>-17569.5</td>
</tr>
<tr>
<td>Shelf Price</td>
<td>13412.05</td>
<td>1443.978</td>
<td>9.288263</td>
<td>6.26E-16</td>
<td>10553.55</td>
<td>16270.55</td>
</tr>
<tr>
<td>Ad</td>
<td>357.2271</td>
<td>57.14106</td>
<td>6.251672</td>
<td>5.88E-09</td>
<td>244.1106</td>
<td>470.3436</td>
</tr>
</tbody>
</table>

Note that Excel provides the F-test, t-ratios, and p-values for the model and coefficients, so you do NOT need to calculate them by hand.

**4.C Interpreting the regression output**

This section illustrates how the regression output from the previous example can be interpreted. A given coefficient implies that, holding all other variables constant, a unit increase in the independent variable will result in a change in the dependent variable equal to the coefficient value. For instance, the coefficient for PAID PRICE is -20319.2. This coefficient is interpreted as follows: holding the other variables constant, a unit (dollar) increase in PAID PRICE will result in a 20319.2
unit decrease in sales. Similarly, the coefficient of 357.23 for ADVERTISEMENT indicates that, holding everything else constant (i.e. PAID PRICE and SHELF PRICE), a unit increase in ADVERTISEMENT will result in a 357.23 unit increase in sales.

The remainder of this section addresses the issues of interpreting the model results with respect to face validity, statistical validity and model validity.

4.C.1 Face Validity

The first step in interpreting the regression output is to assess the face validity of the model. To do this assessment, we must determine what the appropriate signs of the variables should be. The signs for two of the variables are straightforward: PAID PRICE should be negative, and ADVERTISEMENT should be positive.

The coefficient for PAID PRICE is -20319.2, which matches the intuition that the higher the price, the lower the sales. Similarly, the coefficient for ADVERTISEMENT is 357.23, and the sign is correct. The final independent variable, SHELF PRICE, is more difficult. Intuitively, the higher the shelf price, the lower the sales should be, which implies that the coefficient should be negative. Therefore, this variable does NOT have face validity, as it does not make sense to say that the higher the shelf price the higher the sales.

An interesting question, however, is determining what caused the coefficient of SHELF PRICE to be positive? Because PAID PRICE is also included in the model, the effect of this variable on the sales is a little different than you would expect: it represents the discount (SHELF PRICE - PAID PRICE) the consumer receives on the product. As such, a larger discount (i.e. increase in SHELF PRICE without an increase in PAID PRICE) should increase sales, which implies that this coefficient should be positive. Because this variable represents a discount, a better way to model this process is to explicitly include a discount variable in the model (e.g., perhaps by subtracting price paid from shelf price and then dividing that result by shelf price in order to create a variable defined as the percentage discount from the original shelf price).

4.C.2 Statistical Validity

This section addresses the issue of whether or not the coefficients are significantly different from zero. The hypothesis that a coefficient is zero is tested by the t-ratio statistic. The critical value for this test with 120 (n-k-l) degrees of freedom, at the five percent probability level is 1.658. To test the coefficients, we must combine the expected sign with the hypothesis: PAID PRICE is expected to be negative, so the t-ratio should be less that -1.658. The realized t-ratio value of -14.63 meets this test. AD is hypothesized to be positive, so the t-ratio should be greater that 1.658. The realized t-ratio value of 6.25 meets this test. Similarly, SHELF PRICE has a positive t-ratio value of 9.29, implying that its effect on sales is significantly greater than zero.

Based on the discussion above we conclude that PAID PRICE has a significant negative effect on sales, that AD has a significant positive effect on sales, and that SHELF PRICE (indicating discount) has a significant positive effect on sales.

4.C.3 Model Validity
The last validity check performed on the model, model validity, looks at the predictive capability of the entire model. In this test, we want to know whether our model is a significant improvement over using the mean (average) value of the dependent variable as our prediction of the dependent variable in any given case. There are two statistics which allow us to evaluate the predictive capability of the model: the $F$-statistic and the R-Squared value for the model.

The $F$-statistic tests the hypothesis that the model does not predict significantly better than the mean. From the model, the $F$-statistic is 184.76, and has degrees of freedom equal to 3 and 122. The critical value for the $F$-statistic, at the five-percent probability level is 2.68 for 3 and 125 degrees of freedom. Because the statistic for the model exceeds this critical $F$, we can conclude with a 95 percent confidence (1-five percent) that the model is significantly better than the mean. This is indicated by the “Significance of F-Test” output which is 3.43E-45 and thus well below 0.05 (i.e. 5%).

The R-squared statistic provides an indication of how much of the variance of the dependent variable is explained by the model. In our case, the R-squared is 0.82. This implies that the model predicts 82 percent of the variation of the dependent variable (sales).
Appendix 1: Peer Evaluation Form

UPON FINALIZING THE MARKETING PLAN, PLEASE FILL OUT AND SIGN THIS FORM. HAND IT IN TO YOUR RECITATION LEADER.

Peer Evaluation Form

Below please assign each of your group members a number from 1 to 10 that best reflects his/her individual contribution to all group work ( 1 means least level of participation while 10 means full participation).

Lack of Participation  1  2  3  4  5  6  7  8  9  10  Full Participation

If everyone contributed equally, give everyone a 10. Take points off from the person who did not contribute fully. If a member did not contribute, you must clearly denote it by deducting an amount of points commensurate with the lack of participation.

These evaluations are confidential and will not be shown to anyone else.

Failure to hand in this form will lead to the assumption that everyone contributed equally, and the points will be so assigned.

Group number: ______  Company/Problem : _______________________

Names:  Participation Ranking:

1 __________________________
2 __________________________
3 __________________________
4 __________________________
5 __________________________
6 __________________________

__________________________

Signature: ___________________________
INSEAD CASE
UNILEVER IN BRAZIL (1997-2007):
MARKETING STRATEGIES FOR LOW-INCOME CONSUMERS
http://knowledge.insead.edu/abstract.cfm?ct=13398